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This job aid is available online: 

• In the Public Folders: 
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The CONNECTIONS Intranet site also contains information about CONNECTIONS training. 

 

Any visible identifying data 
in this Job Aid is simulated. 
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Overview of Build 16 Safety Assessment Enhancements 

With the Implementation of Build 16, there will be several enhancements to the Safety 
Assessment functionality. The enhancements are covered in detail in this Job Aid and include 
the following topics: 

• Accessing and modifying the Safety Assessment directly from the CPRS window 

• Creation of tabs on the Safety Assessment window to facilitate organization and ease of 
use in completing Safety Assessments 

• Clarification and rewording of the Safety Factors and the ability to distinguish those that 
put the child(ren) in immediate danger of serious harm 

• New Safety Decisions that reflect on and are more consistent with, casework practice 

• Modifying or viewing an existing Safety Assessment 

• Printing and saving the Safety Assessment 

• Safety Assessment To-Do’s and Events 

 

Safety Assessment 

The first priority after receiving a report from the State Central Register (SCR) is to assess each 
child’s safety. The safety assessment process is documented by completing the Safety 
Assessment in CONNECTIONS. The purposes of this assessment are to ascertain whether 
there are any safety concerns, if any children are likely to be in immediate danger of serious 
harm, and to determine what interventions can be initiated or should be maintained to provide 
appropriate child protection. When child safety has been addressed, then a risk assessment of 
future abuse and maltreatment, a comprehensive assessment of family functioning, and a 
thorough investigation of reported allegations can proceed. 

Safety Assessments are completed: 

• Within seven (7) days from receipt of a report of suspected child abuse/maltreatment. 

• In response to any registered “subsequent” reports and must also be completed within 
seven (7) days from receipt of the subsequent report. 

• Within twenty-four (24) hours from receipt of a Fatality report, if there are surviving 
siblings and when completing a 30-day child fatality report. 

• Within seven (7) days of the completion and submission of the Investigation Conclusion. 

• As part of the Family Assessment and Service Plan (FASP), completed at each Initial, 
Comprehensive and Reassessment UCR. 

Safety vs. Risk 
To support the child welfare goals of safety, permanency and well-being for children and their 
families, two assessments are completed during the course of every CPS Investigation, 
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addressing safety and risk. Safety refers to the immediate danger of serious harm; risk refers to 
the likelihood of future abuse or maltreatment. 

Safety 

• Safety deals with present or impending danger. 

• Safety factors pose a threat of immediate harm. 

• Safety factors pose a threat of serious harm. 

• In order to control for safety, there must be an assessment of the need for immediate 
interventions, as well as strengths, resources or protecting factors present in the home. 

Risk 

• Risk is the likelihood that a child may be abused or maltreated in the future. 

• Risk Elements identify significant behaviors and circumstances within a family unit that 
create different levels of risk to the child. 

• Risk may be very high even if the report is unfounded; conversely, risk may be low even 
if the report is indicated. 

• Risk may be reduced with appropriate services, changes in the caretaker’s behavior, 
and family or community support. 

Fatality – No Surviving Children 
Workers will use the new Fatality – No Surviving Children check box on the CPS Investigation 
Conclusion window to confirm that there are no surviving children in the stage. This check box 
enables if the Investigation contains all of the following: 

• A DOA/Fatality allegation 

• A Date of Death (DOD) for the AB child associated with the fatality allegation 

• No other persons younger than 18 years of age with a role of MA, AB or No Role 
 

When all of these conditions exist, the Fatality – No Surviving Children check box will enable 
and the following message will display: 

“Fatality – No surviving children. Please check box to confirm.” 
 

If the worker selects the check box, the stage can be submitted 
for approval without a completed Safety Assessment or Risk 
Assessment Profile (RAP). The event status for the Safety 
Assessment and RAP will be changed automatically to “SUSP” 
(Suspended), unless the status for that event is already APRV 
(Approved) at the time that the supervisor approves the 
Investigation Conclusion. 

If any of the following events occur before you submit the 
Investigation Conclusion for approval, the Fatality – No Surviving Children check box will 
disable and the worker must complete a RAP (for implemented stages only) and a Safety 
Assessment (for both pre-Build 16 and implemented stages): 

 
If the worker does not select the 
Fatality-No Surviving Children 
check box, s/he must complete 

the Safety Assessment.  
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• A person younger than 18 years of age who has a role of MA, AB or No Role is added to 
the stage. 

• The age of a person with a role of No Role is changed to be younger than 18. 
 

Accessing the Safety Assessment Tab  
Prior to Build 16, the Safety Assessment was a task on the Task List for a CPS Investigation 
stage. With the implementation of Build 16, the Safety Assessment will be accessed from the 
Child Protective Record Summary task on the Task List. This task provides access to a multi-
tabbed window which includes the Safety Assessment tab. Accessing a Safety Assessment 
from the Staff To-Do List, Event List or Approval Status window will be accomplished in the 
same manner for both implemented and pre-Build 16 stages.  

With the implementation of Build 16, the Safety Assessment will be accessed and maintained in 
the Child Protective Record Summary (CPRS). In addition, Build 16 will clarify Safety Factors; 
enable caseworkers to identify Safety Factors that place the child(ren) in immediate danger; and 
modify safety decisions and interventions to support the child(ren)’s safety. Build 16 also 
provides a two-tiered decision making process, by first selecting Safety Factors and then 
selecting those factors that place the child(ren) in immediate danger. 

The ability to create, modify, view or submit the Safety Assessment in CONNECTIONS is 
defined as follows: 

• The Primary worker assigned to the stage (or a member of the Primary worker’s unit 
hierarchy) will be able to create, modify and submit the Safety Assessment. 

• The Secondary worker assigned to the stage (or a member of the Secondary worker’s 
unit hierarchy) will be able to create, modify and submit the Safety Assessment. 

• Any worker who has been assigned a Safety Assessment Task To-Do will be able to 
modify the Safety Assessment. 

• Anyone with the appropriate security to open the Child Protective Record Summary 
window in view-only mode will be able to view the Safety Assessment. 
 

The navigational path for accessing the Safety Assessment tab is determined by the role of the 
worker who is accessing the tab and whether the Safety Assessment will be accessed in view-
only or modify mode. 

To access the Safety Assessment tab in modify mode: 

• The caseworker selects the Child Protective Record Summary task from the Task List 
for the Investigation stage and clicks on the Safety Assessment tab in the CPRS. 
 
—OR— 

• The caseworker navigates from a system-generated Task To-Do on the Staff To-Do List 
or Case To-Do List to complete the Safety Assessment. When the Child Protective 
Record Summary window opens, the Safety Assessment tab is active. 
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To access the Safety Assessment tab in view-only mode: 

• The worker selects the CPRS event from the Event List for the Investigation stage and 
clicks on the Safety Assessment tab in the CPRS. 

—OR— 

• If the supervisor or Unit Approver navigates from a system-generated Safety 
Assessment Approval Task To-Do on the Staff To-Do List or Case To-Do List, the Child 
Protective Record Summary window opens and the Safety Assessment tab is active. 

—OR— 

• If the supervisor navigates from the Investigation Conclusion approval Task To-Do on 
the Staff To-Do List or Case To-Do List, the Child Protective Record Summary window 
opens and the Case Identification tab is active. The supervisor then clicks on the 
Safety Assessment tab. 

Any worker who has the ability to create, modify or view a Safety Assessment prior to Build 16 
will have the same access to the new Safety Assessment functionality in the CPRS.  

A pre-Build 16 stage (any CPS stage with an Intake date prior to the implementation of Build 16) 
will be accessed, viewed and modified in the same way it was prior to Build 16. An implemented 
stage (any CPS stage with an Intake date on or after implementation) will use the new Safety 
Assessment functionality. 

CPRS Safety Assessment Tab  
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With the implementation of Build 16, the Safety Assessment will be completed in the CPRS 
during the Investigation stage. The Safety Assessment tab lists all Safety Assessments for a 
stage, including the assessment date, assessment type, event transaction date, event status 
and decision. From this tab, the worker will be able to: 

• create a new Safety Assessment; 

• modify/view an existing Safety Assessment; 

• print an existing Safety Assessment;  

• assign a Safety Assessment Task To-Do to another 
worker; 

• submit a completed Safety Assessment for approval;  

• view the approval status of a completed and submitted Safety Assessment; and 

• access context-sensitive Online Help information. 
 

Buttons on the Safety Assessment Tab 
The following buttons will display at the bottom of the Safety Assessment tab: 

To Do Creates a Task To-Do for the Safety Assessment. 

Submit Submits the Safety Assessment to the supervisor for 
approval; enables only when the status is COMP. 

Approval Status Opens the Approval Status window, which displays the 
status of a submitted Safety Assessment. Enables only 
when the Safety Assessment is in PEND, REJT or APRV 
status (See “Safety Assessment Events” on page 24.) 

New  Opens the new Safety Assessment window. If a completed 
and approved Safety Assessment exists for a stage, the 
new Safety Assessment will be pre-populated with the 
Safety Factors, Safety Decisions, Safety Interventions and 
narratives recorded in the most recently 
completed/submitted Safety Assessment. 

Detail Opens an existing Safety Assessment (selected from the 
list on the tab). 

Print Prints an existing Safety Assessment (selected from the 
list on the tab). 

 
Caseworkers will still be able to 
view all Safety Assessments for 
a case with Build 16, by using 
the Safety Assessment for 
Case task on the Task List. 
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The Safety Assessment Window 

 
 

When a worker selects an existing Safety Assessment or creates a new one from the Safety 
Assessment tab, the new Safety Assessment window will open. The new Safety Assessment 
window is divided into three sections: 

• The Header contains the Date and Type fields, which are completed by clicking on each 
field’s drop-down arrow and selecting from the resulting list.  

• The Tabbed section contains four tabs: Safety Factors, Mitigating 
Strengths/Resources, Safety Decision and Safety Interventions.  

• The Footer contains the following buttons:  

Complete? Checks the Safety Assessment to verify if all elements 
have been completed. 

Save Saves work that has been recorded in the Safety 
Assessment and closes the Safety Assessment window. 
The following message will display: “Changes have been 
saved.” 

Save and Submit Saves work that has been recorded in the Safety 
Assessment and submits the Safety Assessment to the 
supervisor for approval; enables only if “Yes” displays next 
to the Complete? button. 
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The following message will display when the worker clicks 
on the Save and Submit button: 

“This action will close this window.  
Do you wish to continue?” 

• Clicking on the Yes button will continue the 
submission process. 

• Clicking on the No button will cancel the 
submission process. 

If the worker clicks on the Yes button in response to the 
message, the following message will display: 

“Changes have been saved.” 

When the worker clicks on the OK button in response to 
this message, the CPRS will close. 

Cancel Closes the window and discards any unsaved data. The 
following message will display: 

“Do you want to cancel? 
Unsaved data and/or narratives will be lost.” 

• Clicking on the Yes button will discard the unsaved 
changes and close the Safety Assessment window. 

• Clicking on the No button will leave the window 
open without discarding the unsaved changes. 

 
The header and footer are always visible, regardless of which tab is open.  

 

 

Step-by-Step: 
Accessing the Safety Assessment Window via the Task List 

1 Open the Task List for the selected stage. 

2 Select the Child Protective Record Summary task and click on the Detail… button. 

3 Click on the Safety Assessment tab. 

4 Click on the New button to create a new Safety Assessment. 
—OR— 
Click on an existing Safety Assessment to select it, then click on the Detail… button. 
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Step-by-Step: 
Accessing the Safety Assessment Window via the Event List 

1 Open the Assigned Workload and select the stage for which you want to see the 
Safety Assessment. 

2 Click on the Options menu and select the Event List… command. 

3 Click on the Safety Assessment event and click on the Detail… button. 
 

 

Step-by-Step: 
Accessing the Safety Assessment Window via the Staff To-Do List 

1 Open the Staff To-Do List. 

2 Click on the Safety Assessment Task To-Do to select it, then click on the Navigate… 
button. 

 

Creating a New Safety Assessment  
During the Intake stage the SCR worker may select certain Safety Factors based on what the 
reporting source has alleged. These Safety Factors recorded at Intake will be carried over into 
the Safety Assessment for the Investigation stage. Within seven days of the Intake, the 
caseworker assigned to investigate the report will complete a Safety Assessment. Based on the 
information collected during the course of the investigation, the caseworker should review each 
Safety Factor and decide whether to maintain the factor, deselect the factor or add a new factor.  

Consider how recent the circumstance, condition or behavior 
associated with each safety factor is. Is the circumstance, 
condition or behavior currently present, likely to occur in the 
immediate future or has it occurred in the recent past? The 
safety factors should not automatically be equated with the 
presence of an "immediate danger of serious harm.’’ Rather, 
the safety factors should be viewed as "red flag alerts," due to 
present identified circumstances, conditions or behaviors. 

All existing Safety Assessments must be in PEND or APRV 
status in order to begin a new Safety Assessment.  

When a worker creates a new Safety Assessment via the New button on the Safety 
Assessment tab, the information from the previously approved Safety Assessment will be 
carried forward into the new Safety Assessment. All data will be pre-populated, but the worker 
will be able to modify this information in the current Safety Assessment. The worker must select 
a Type from the drop-down list and select a date from the Date field, which will be pre-filled with 
the current date. The worker may accept the current date, or change it by either using the drop-
down arrow or typing directly in the field. The date should reflect when the caseworker actually 
assessed the safety of the child(ren). 

 
Safety Factors selected at the 

Intake stage are part of the 
official case record and cannot 
be changed within the Intake 

stage. The factors can be 
changed during the 
Investigation stage. 
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Step-by-Step: 
Creating a New Safety Assessment 

1 Open the Task List for an Investigation stage. 

2 Click on the Child Protective Record Summary task. 

3 Click on the Detail… button. 

4 Click on the Safety Assessment tab. 

5 Click on the New button. 
—OR— 
Select a Safety Assessment with a status of NEW and click on the Detail button. 

6 Click on the drop-down arrow for the Type field and select a Safety Assessment 
type.  

7 Select a date from the Date field.  
This field will be pre-filled with the current date. You may use this date, select a 
different date from the drop-down arrow, or enter a date manually into the field. 
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Tabs on the Safety Assessment Window 
There are four tabs on the Safety Assessment window: Safety Factors, Mitigating 
Strengths/Resources, Safety Decision and Safety Interventions. The tabs provide 
convenient access to information contained in the Safety Assessment. The tabs can be 
accessed/viewed in any order. 

Safety Factors Tab 

 
When the Safety Assessment is accessed via the CPRS the 
Safety Factors tab is active. The upper half of the tab contains 
a list of Safety Factors with corresponding check boxes. The 
worker will select one or more Safety Factors from the list, as 
applicable. If no Safety Factors are present, the worker will 
click on the No Safety Factors Identified check box. Selecting 
this check box will disable the Safety Factors. If the worker 
selects any Safety Factors, the No Safety Factors Identified 
check box will disable.  

The selected Safety Factors will display in the grid on the lower 
half of the tab. The worker must review these Safety Factors 
and select those (if any) that place the child(ren) in immediate 
danger of serious harm, by clicking on the corresponding check 
box. The worker is not required to select any factors from the 
immediate danger factors list. 

The Comment field, located on the right side of the tab, is 
used to record a description of the relevant behaviors and/or 
circumstances related to the selected Safety Factors. If the 
worker attempts to navigate to another tab before recording 

 
Build 16 modifies the wording of 

several Safety Factors and 
separates drug and alcohol 

abuse into two different  
Safety Factors. 

 
The Comments field is used to 

record comments for all 
selected Safety Factors. There 
is not a separate Comments 

field for individual Safety 
Factors. The field allows up to 

4,000 characters. 
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information in the Comment field, the following message 
displays: 

“You must comment on the selected Safety Factors.” 

The worker will still be able to navigate to other tabs, but will 
not be able to complete and submit the Safety Assessment 
until comments are recorded. If No Safety Factors Identified 
is selected on the Safety Factors tab, comments do not need 
to be recorded in the Comment field. 

When a caseworker opens the 7-Day Safety Assessment for an Investigation stage, the 
Comment field will be highlighted in yellow (indicating that it is a required field), since Safety 
Factors were recorded by the SCR at Intake. If the caseworker deselects all of the SCR-
recorded Safety Factors, the Comment field will no longer be highlighted in yellow and the No 
Safety Factors Identified check box will enable. If the caseworker selects any Safety Factors, 
the Comment field will once again highlight in yellow. 
 

Build 16 Safety Factors 
• Caretaker(s) previously committed or allowed abuse or maltreatment of a child(ren), 

and the caretaker’s prior response to that incident was not commensurate with the 
severity of the abuse or maltreatment. 

• Caretaker(s) currently abuses alcohol, to the extent that it seriously affects his/her 
ability to supervise, protect or care for the child(ren). 

• Caretaker(s) currently abuses drugs, to the extent that it seriously affects his/her 
ability to supervise, protect or care for the child(ren). 

• Child(ren) has experienced or is likely to experience physical or psychological harm, 
as a result of domestic violence in the household. 

• Caretaker(s)’s apparent or diagnosed mental health status or developmental disability 
seriously affects his/her ability to supervise, protect or care for the child(ren). 

• Caretaker(s) is violent and appears out of control. 

• Caretaker(s) appears unwilling and/or unable to meet the child(ren)’s basic needs for 
food, clothing, shelter and/or medical care. 

• Caretaker(s) appears unwilling and/or unable to provide adequate supervision of the 
child(ren). 

• Caretaker(s) likely caused serious physical harm to the child(ren) or has made a 
plausible threat of serious harm. 

• Caretaker(s) views, describes or acts toward the child(ren) in predominantly negative 
terms and/or has extremely unrealistic expectations of the child(ren). 

• Child(ren)’s current whereabouts cannot be ascertained and/or there is reason to 
believe the family is about to flee or refuses access to the child(ren). 

• Child(ren) has been or is suspected of being sexually abused and the caretaker(s) is 
unable or unwilling to provide adequate protection of the child(ren). 

 
For examples and definitions of 

the Safety Factors, see 
Appendix A on page 26. 
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• The physical living conditions are hazardous. 

• Child(ren) is afraid of and/or extremely uncomfortable around people living in or 
frequenting the home. 

• Child Has Positive Toxicology for drugs and/or alcohol. (NYC Required) 

• Child(ren) is on Sleep Apnea Monitor. (NYC Required) 

• Weapon noted in CPS report or found in the home. (NYC Required) 

• Other (specify in comments). 

• No Safety Factors Identified. 

 

1 From the Safety Factors tab on the Safety Assessment window, select the Safety 
Factors that apply by clicking on their corresponding check boxes. 
The Safety Factors selected will display in the lower grid. 
—OR— 
Select the No Safety Factors Identified check box. 

2 Record comments in the Comment field regarding behavior or circumstances that 
relate to the selected Safety Factors. 

3 Review the Safety Factors and select those that place the child(ren) in immediate 
danger of serious harm by clicking on the corresponding check box. 

4 Click on the Save button if the Safety Assessment is not complete. 
The following message will display: 
“This action will close this window. Do you wish to continue?” 
Click on the Yes button to save the information to the database and close the Safety 
Assessment window. 
—OR— 
Click on the File menu and select Save and Stay to save the information to the 
database and leave the Safety Assessment window open. 
—OR— 
Click on the Cancel button if you want to close the Safety Assessment window 
without saving the information you recorded. 

 

Step-by-Step: 
Recording Safety Factors  
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Mitigating Strengths/Resources Tab 
The second tab on the Safety Assessment window is the Mitigating Strengths/Resources tab. 
This tab allows workers to record a narrative describing any family strengths and/or 
neighborhood or community resources available and how they mitigate or address safety 
concerns for the child(ren). Workers may record this narrative at any time during the Safety 
Assessment. This text field has an unlimited amount of space. 

 
This window features the new Text Control functions, which work similarly to many of the basic 
formatting functions in Microsoft Word, such as bold, italics, bulleted and numbered lists, 
copy/paste and Spell Check. 

A system edit requires the caseworker to record a narrative on the Mitigating 
Strengths/Resources tab when s/he selects Safety Decision #2 (“One or more safety factors 
are present, however these factors do not place a child in immediate danger of serious harm 
and/or the existence of family strengths, resources or other mitigating circumstances has 
effectively removed the threat of immediate danger for the child(ren)”). The worker will be able 
to save the Safety Assessment, but will not be able to submit it for approval until the narrative is 
completed. For all other Safety Decisions, the recording of this narrative may be required by 
local district policy and procedure. 

1 Click on the Mitigating Strengths/Resources tab. 

2 Record a narrative regarding the strengths and resources of the family. 

 

Step-by-Step: 
Recording Mitigating Strengths/Resources  
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3 Click on the Save button to save the information to the database and close the 
Safety Assessment window. 
—OR— 
Click on the File menu and select Save and Stay to save the information to the 
database and leave the Safety Assessment window open. 

 

Safety Decision Tab 
The third tab on the Safety Assessment window is the Safety Decision tab. The new Safety 
Decisions with Build 16 are a significant enhancement to the system, providing caseworkers 
with decisions that are more consistent with casework practice. A Safety Decision is the 
worker’s conclusion of whether the child is safe in the home. All of the other components of the 
Safety Assessment are used by the worker to support this decision: the assessment of 
immediate danger of serious harm, family strengths and/or family, neighborhood or community 
resources that mitigate or address safety concerns, and safety interventions that have been 
initiated. Once the Safety Factors tab is completed, the worker can complete the Safety 
Decision tab. Only one Safety Decision can be selected.  

 

 

The Five Safety Decisions 
1.  No safety factors were identified at this time. Based on currently available information, 

there are no child(ren) likely to be in immediate danger of serious harm. (The worker 
does not select this decision; it is pre-filled by the system if No Safety Factors 
Identified is selected on the Safety Factors tab.) 

2.  One or more safety factors are present, however, these factors do not place a child in 
immediate danger of serious harm, and/or the existence of family strengths, 
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resources or other mitigating circumstances has effectively removed the threat of 
immediate danger for the child(ren). 

3.  One or more safety factors are present, which place a child in immediate danger of 
serious harm, and controlling safety interventions have been initiated. Based on the 
controlling safety interventions, the child(ren) will remain in the home at this time. 

4.  One or more safety factors are present, which place a child’s life or health in imminent 
danger and removal to foster care or an alternative placement (or continued 
placement) is the only controlling safety intervention possible for one or more of the 
children. 

5.  One or more safety factors are present, which place a child in immediate danger of 
serious harm, but caretaker(s) has refused access to the child or fled, or child’s 
whereabouts are unknown. Appropriate legal/investigative actions are being taken. 

 
On this tab, workers must select one and only one Safety Decision from the list. 

• If the No Safety Factors Identified check box was selected on the Safety Factors tab, 
the No Safety Factors Apply check box will automatically be selected on the Safety 
Decision tab; all other Safety Decisions will be disabled. 

• If the worker selects any Safety Factor other than No Safety Factors Identified, Safety 
Decision #1 will be disabled. 

• If the worker chooses Safety Decision #4 (see Safety Decisions above), the Placement 
window will open automatically. (See “The Placement Window” on page 17.) The 
Placement window must be completed in this situation. 
 

The following conditions apply to the Safety Decision tab: 

• The worker must select at least one Safety Factor (or the No Safety Factors Identified 
check box) on the Safety Factors tab before selecting a Safety Decision on the Safety 
Decision tab. If s/he attempts to select a Safety Decision without selecting at least one 
Safety Factor (or the No Safety Factors Identified check box), the following message 
will display: 

“You must select at least one Safety Factor before selecting a Safety Decision.” 

• A system edit will only allow one Safety Decision to be selected. The worker may 
change the selected Safety Decision by clicking on a different one, which will clear the 
check box for the previous choice. A Safety Decision must be selected before the Safety 
Assessment can be submitted for approval.  

• The worker is required to select at least one safety intervention if s/he selects Safety 
Decision #3. 

• If Safety Decision #3 was selected on the Safety Decision tab, the worker must select 
at least one Safety Intervention other than “Placement - Foster Care” or “Placement - 
Alternate Caregiver.” 
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Step-by-Step: 
Recording the Safety Decision 

1 Click on the Safety Decision tab. 

2 Select one of the five possible Safety Decisions by clicking on its corresponding 
check box. 

3 Complete the required fields and windows based on the selected Safety Decision. 
(See the conditions on the previous page.) 

4 Click on the Save button. 
 

The Placement Window 
The Placement window allows workers to select, from a list of 
all children in the stage, those who have been placed. The 
Placement window is divided into two sections. The left side of 
the window lists all of the children in the stage. Each child’s 
name has a corresponding check box. The right side of the 
window contains a text field where the worker must identify the 
protecting factors that allow each child to remain safely in the 
home. To indicate that a child has been removed from the 
home, the worker selects the child’s name by clicking on the 
child’s corresponding check box, as appropriate. 

If the worker selects Safety Decision #4, the Placement window will open automatically.  

 
 

 
The Placement window is 

unique in that comments are 
required for any check box not 
selected rather than those that 

are selected. 
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Three buttons display at the bottom of the Placement window: 

• The Spell Check button enables the worker to check 
the narrative for spelling errors. 

• The OK button closes the Placement window and 
returns the worker to the Safety Decision tab on the 
Safety Assessment window. The information recorded 
on the Placement window will not be saved until the 
worker clicks on the Save button (or selects the Save and Stay command from the File 
menu) on the Safety Assessment window. 

• The Cancel button discards any unsaved changes, closes the Placement window and 
returns the worker to the Safety Decision tab on the Safety Assessment window. 

To review or change the placement information, click on the Placement button on the Safety 
Decision tab. If any children remain in the home, the worker must record comments regarding 
why the child(ren) can remain safely in the home. 

 

Step-by-Step: 
Recording Placement Information 

1 On the Safety Decision tab, Safety Decision #4 must be selected. 
The Placement window displays. (Note: If you need to re-enter the placement 
window after information has been recorded and saved, click on the Placement 
button.) 

2 Click on the check box next to the name of each child who has been placed in foster 
care or alternative placement. 

3 If applicable, record Comments regarding the protecting factors that allow each child 
to remain safely in the home.  
See tip box above. 

4 Click on the OK button. 
 

 
Protecting factors include family 

strengths and/or  
outside interventions. 
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Safety Interventions Tab 
If the caseworker determines that the child(ren) are not safe in 
the current home environment, s/he will use the Safety 
Interventions tab to select interventions that control for the 
immediate health and safety of the child. One or more Safety 
Interventions may be selected from the list, indicating which 
intervening action has been taken to support the child’s safety 
based on the Safety Factors and Safety Decisions the worker 
has selected. Each Safety Intervention the worker selects must 
be supported by comments. 

 
The Safety Interventions tab is divided into two sections. The left side contains a list of 
interventions designed to control for the immediate health and safety of the child(ren). The 
worker may select one or more interventions, as applicable. 
The right side of the tab contains a text field for recording 
comments that describe how the selected interventions control 
for the immediate health and safety of the child(ren).  

The following conditions apply to the Safety Interventions tab: 

• If one or more Safety Interventions are selected, 
Comments must be recorded. The worker can save 
without comments, but the Safety Assessment will not 
be complete and cannot be submitted for approval. 
Only one comment will be required, even if multiple 
Safety Interventions are selected. 

 
• If Safety Decision #3 was selected on the Safety Decision tab, the worker must select 

at least one Safety Intervention other than “Placement - Foster Care” or “Placement - 
Alternate Caregiver.” At least one intervention must be selected to complete the Safety 
Assessment and submit it for approval. 
 

 
For definitions and explanations 

of Safety Interventions, see 
Appendix B on page 31. 

 
The Comments field is used to 

record comments for all 
selected Safety Interventions. 

There is not a separate 
Comments field for individual 
Safety Interventions This field 
allows up to 2,000 characters. 
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Safety Interventions 
• Intensive Home Based Family Preservation Services 
• Emergency Shelter 
• The non-offending caretaker is moving to a safe 

environment with the children.  
• Authorization of emergency food/cash/goods 
• Judicial Intervention  
• Law Enforcement Involvement 
• Emergency Medical/Mental Health Services 
• Immediate and regulated in-home supervision/monitoring 
• Emergency Alcohol Abuse Services 
• Emergency Drug Abuse Services 
• Correction or removal of hazardous/unsafe living conditions 
• Placement - Foster Care 
• Placement - Alternate Caregiver 
• Use of family, neighbors or other individuals in the community as safety resources 

(specify) 
• Alleged perpetrator has left the home voluntarily, current caretaker will appropriately 

protect the victim with CPS monitoring 
• Alleged perpetrator has left the home in response to legal action 
• Other (specify)  
 

 

Step-by-Step: 
Recording Safety Interventions  

1 Click on the Safety Interventions tab. 

2 Select an intervention by clicking on its corresponding check box. 
More than one Safety Intervention can be selected. 

3 Record comments in the text field regarding the interventions that were selected and 
how those interventions will control for the safety of the child(ren). 

4 Click on the Save button. 
—OR— 
Click on the File menu and select Save and Stay. 

 

Checking for Completion of the Safety Assessment 
The Complete? button on the Safety Assessment window provides the worker with an easy 
method of determining whether the Safety Assessment is complete. When the worker clicks on 
the Complete? button, CONNECTIONS will verify that all parts of the Safety Assessment have 
been completed. If the Safety Assessment is complete, “Yes” will display next to the 
Complete? button and the Save and Submit button will enable. If the Safety Assessment is not 
complete, a message will display, indicating the item(s) requiring completion.  

In order to complete the Safety Assessment, the following conditions apply: 

• If any Safety Factor(s) are selected other than No Safety Factors Identified, comments 
must be recorded. 

 
Safety Interventions have been 

modified to distinguish 
immediate interventions from 

ongoing services. 
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• If any Safety Interventions are selected, comments must be recorded. 

• If No Safety Factors Identified is selected on the Safety Factors tab, then No Safety 
Factors Selected must be the selected Safety Decision. 

• If Safety Decision #2 (mitigating) is selected, the Mitigating Strengths and Resources 
narrative must be recorded. 

• If Safety Decision #3 (interventions) is selected, at least one Safety Intervention must be 
selected other than Placement – Foster Care or Placement – Alternative Caregiver. 

• If Safety Decision #4 (placement) is selected, the Placement window must be 
completed. 

• If any children listed on the Placement window remain unselected, comments must be 
recorded. 

• A Safety Decision must be recorded. 

• The Date and Type fields must be completed. 

 

Saving the Safety Assessment 
At any time during the Safety Assessment recording process, the worker can save the work 
completed to that point. CONNECTIONS records the status of the work as either in process 
(PROC) or complete (COMP). Saving can be done in a number of ways: 

• Click on the Save button (or click on the File menu and select the Save command) to 
save the information and close the Safety Assessment window. 

• Click on the File menu and select the Save and Stay command to save the work without 
closing the window. 

• Click on the Save and Submit button to save the work and submit it for supervisory 
approval. 

 

Printing the Safety Assessment 
Workers will be able to print the Safety Assessment as needed. For example, their local district 
may require that a hard copy of the Safety Assessment be kept in the external case file; or 
perhaps the document is needed in court. 

Any worker who has access to the Safety Assessment via the CPRS will have the ability to print 
the Safety Assessment. Safety Assessments may be printed from the Safety Assessment tab, 
Safety Assessment window or Generate Report window.  
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The Print All button in the CPRS, which was used prior to 
Build 16, is now the Generate Report button. The worker can 
specify which CPRS tabs to print (instead of having to print the 
entire CPRS). A single Safety Assessment, a series of Safety 
Assessments or all Safety Assessments for the investigation 
stage can be printed from the Safety Assessment tab. A 
report of all Safety Assessments for the Investigation stage can 
be printed from the Generate Report window. 

Once the worker selects the Safety Assessment(s) to be printed and clicks on the Print button, 
the system will preview the Safety Assessment(s) in Adobe Acrobat. Clicking on the Print 
button on the Adobe Acrobat document window will print the selected Safety Assessment(s). 

 

Viewing or Modifying an Existing Safety Assessment 
To modify an existing Safety Assessment, a worker must navigate to the Child Protective 
Record Summary task via the Task List, Staff To-Do List or Case To-Do List and click on the 
Safety Assessment tab (if it is not already the active tab) once the CPRS opens. If a Safety 
Assessment is accessed via the Event List or the Approval Status window, the Safety 
Assessment will be in view-only mode and the To-Do, Submit and New buttons will be 
disabled. 

To modify a Safety Assessment, the status must be PROC, COMP, PEND or REJT. (See 
“Safety Assessment Events” on page 24.) Safety Assessments in APRV status are view-only 
and cannot be modified.  

To modify or view an existing Safety Assessment, highlight it from the list and click on the Detail 
button. The Safety Assessment window will display with all previously recorded information. 
When a worker saves changes to the Safety Assessment without checking for completion, the 
status of the Safety Assessment will be PROC. 

If the worker accesses the Safety Assessment in modify mode after it has been saved and 
submitted for supervisory approval (PEND status), the following message will display: 

“Saving will invalidate the pending approval. Do you wish to continue?” 

• Clicking on the Yes button will open the Safety Assessment in modify mode; any 
changes that are saved to the Safety Assessment will invalidate the pending approval. 

• Clicking on the No button will open the Safety Assessment in view-only mode. 
 

 

Step-by-Step: 
Viewing/Modifying an Existing Safety Assessment 

1 Open the Task List for an Investigation stage. 

2 Click on the Child Protective Record Summary task. 

3 Click on the Detail… button. 

4 Click on the Safety Assessment tab. 

5 Select the Safety Assessment you want to view or modify. 

 
To select multiple Safety 

Assessments, hold down the 
Ctrl key as you click on 

each Safety Assessment 
you need to print. 



 

CONNECTIONS – System Build 16 Safety Assessment Job Aid – (09/24/2003) Page 23 

6 Click on the Detail button. 
The selected Safety Assessment displays. 

7 View or record information as desired and click on the Save button. 
 

The Approval Status Window 
With the implementation of Build 16, workers will be able to access the Approval Status window 
within the CPRS by selecting a Safety Assessment and clicking on the Approval Status button 
on the Safety Assessment tab. This button will enable only when the selected Safety 
Assessment is in PEND, REJT or APRV status. 

The Approval Status window will display information about the approval status of the selected 
Safety Assessment. The Approval Status window is view-only.  

 

The Approval Status contains the following fields: 

Case Name The name of the case with which the approval is associated 

Approval Topic The type of work that was submitted for approval 

Date The date the approval was completed 

Time The time the approval was completed 

Approver The name of the person who approved or rejected the work 

Status The status of the approval  

Comments Displays comments recorded by the supervisor 

Clicking on the Close button will close the Approval Status window and return the worker to the 
Safety Assessment tab in the CPRS. 

 

Step-by-Step: 
Viewing the Approval Status Window 

1 Click on the Safety Assessment tab.  
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2 Click on a Safety Assessment (in PEND, REJT or APRV status) to select it from the 
list. 

3 Click on the Approval Status button. 
The Approval Status window displays. 

4 To close the Approval Status window, click on the Close button. 

 

Safety Assessment Events  
The table below lists the Events and their corresponding statuses for Safety Assessment 
activities. Statuses can be viewed on the Event List. 

NEW An event has been generated but no work has been saved 
(e.g., a Safety Assessment in an Investigation stage that has not 
been accessed). 

PROC The item is in process. Work has been saved but not yet 
completed (e.g., some Safety Assessment information entered by 
worker but not ready to be submitted for supervisory approval). 

COMP Work has been completed and saved, but not yet submitted for 
approval (e.g., a Safety Assessment that is completed and saved 
but not yet submitted for supervisory approval). 

PEND Work has been submitted and is pending approval (e.g., a Safety 
Assessment that has been Saved and Submitted, but which the 
supervisor has not yet approved or rejected). 

REJT The supervisor has rejected the submitted Safety Assessment. The 
caseworker must correct the Safety Assessment and re-submit it. 

APRV The submitted work has been approved by the supervisor (and any 
additional approvers, if applicable). Upon approval, the event is 
“frozen” along with all of its related windows (e.g., the supervisor 
has approved a Safety Assessment). 

SUSP The Investigation stage has been closed as a duplicate (and the 
Safety Assessment was never approved by the supervisor).  

 

Assigning Safety Assessment Task To-Do’s 
Any worker who can create a new Safety Assessment can assign a Safety Assessment Task 
To-Do. On the Safety Assessment tab, the worker can click on the To-Do button or select the 
Create To-Do command from the Options menu. At this point the system-generated 
information will be sent to the To-Do Detail window. If the Create To-Do command is selected 
while the Safety Assessment is pending supervisory approval, the following message will 
display:  

“Do you wish to link the <enter event type> To Do to the latest event?” 

Regardless which method is used to create the To-Do, it will navigate to the Safety Assessment 
window in modify mode. 
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Intake Narrative 
At the time of Intake, the SCR worker records a narrative of the report that includes as much 
information as is known by the reporter at the time of the call. This Intake Narrative can be 
viewed in the CPRS. The Intake Narrative enables the caseworker to refer back to the original 
report narrative when conducting an investigation. With the implementation of Build 16, 
caseworkers can use the Intake Narrative button in the CPRS footer to view this information. 
The Intake Narrative will also be accessible via the Options menu on the Safety Assessment 
window. 

 

Step-by-Step: 
Viewing the Intake Narrative from the Options Menu 

1 Click on the Safety Assessment tab. 

2 Click on a Safety Assessment to select it. 

3 Click on the Options menu and select the Intake Narrative command. 
The Intake Narrative displays. 
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Appendix A: CPS Safety Factors Definitions 

 
The examples for each safety factor listed below 
are intended to guide the worker’s selection of 
safety factors currently present. The examples 
should not be considered as an all-inclusive list 

of possible circumstances, conditions or 
behaviors related to each safety factor. Other 

circumstances, conditions or behaviors may be 
associated with each safety factor that may 

indicate the possibility of immediate danger of 
serious harm.  

 

Caretaker(s) previously committed or allowed abuse or maltreatment of a child(ren), and 
the caretaker’s prior response to that incident was not commensurate with the severity of 
the abuse or maltreatment. 

• Prior abuse or maltreatment (may include non-reported accounts of abuse or 
maltreatment) that were serious enough to cause or could have caused severe injury 
or harm to the child(ren). 

• Caretaker(s) has retaliated or threatened retribution against child(ren) for past 
incident(s) of abuse or maltreatment. 

• Escalating pattern of abuse or maltreatment. 
• Caretaker(s) does not acknowledge or take responsibility for prior inflicted harm to 

the child(ren) or explains incident(s) as not deliberate. 
 

Caretaker(s) currently abuses alcohol to the extent that it seriously affects his/her ability 
to supervise, protect or care for the child(ren). 

• Caretaker(s) has misused alcohol to the extent that control of his/her actions is 
significantly impaired.  As a result, the caretaker(s) is unable or likely to become 
unable to care for the child, or has harmed the child, or is likely to harm the child.  

• Newborn child with positive toxicology for alcohol in his/her bloodstream or urine 
and/or was born with fetal alcohol effect or fetal alcohol syndrome.  

 

Caretaker(s) currently abuses drugs to the extent that it seriously affects his/her ability to 
supervise, protect or care for the child(ren).  

• Caretaker has misused illegal and/or prescription drugs to the extent that control of 
his or her actions is significantly impaired.  As a result, the caretaker is unable or 
likely to become unable to care for the child, or has harmed the child, or is likely to 
harm the child.  

• Newborn child with positive toxicology for illegal drugs in his/her bloodstream or urine 
and/or was born dependent on drugs or with drug withdrawal symptoms.  
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Child(ren) has experienced or is likely to experience physical or psychological harm, as a 
result of domestic violence in the household. 

Examples of direct threats to child(ren): 

• Observed or alleged domestic violence batterer is confronting and/or stalking the 
caretaker/victim and child(ren) and has threatened to kill, injure, or abduct either or 
both. 

• Observed or alleged domestic violence batterer has had recent violent outbursts that 
have resulted in injury or threat of injury to the child(ren) or the other 
caretaker/victim. 

• Caretaker/victim is forced, under threat of serious harm, to participate in or witness 
serious abuse or maltreatment of the child(ren). 

• Child(ren) is forced, under threat of serious harm, to participate in or witness abuse 
of the caretaker/victim. 
 

Other examples of Domestic Violence: 

• Caretaker/victim appears unable to provide basic care and/or supervision for the 
child because of fear, intimidation, injury, incapacitation, forced isolation, fear or 
other controlling behavior of the observed or alleged domestic violence batterer. 

• Psychological abuse examples: undermining a person’s sense of self-worth; instilling 
fear; attempting to isolate one from family and/or friends. 

• Physical abuse examples: inflicting or attempting to inflict physical injury; withholding 
access to resources necessary to maintain health; forced drug use. 

• Sexual abuse example: coercing any sexual contact without consent. 
• Economic abuse example: making or maintaining one financially dependent.  

 

Caretaker(s)’s apparent or diagnosed mental health status or developmental disability 
seriously affects his/her ability to supervise, protect or care for the child(ren). 

• Caretaker exhibits behavior that seems out of touch with reality, fanatical, bizarre, 
and/or extremely irrational. 

• The caretaker(s) lacks or fails to utilize the necessary supports related to his/her 
developmental disability, which has resulted in serious harm to the child or is likely to 
harm the child seriously in the very near future. 

 

Caretaker(s) is violent and appears out of control. 

• Extreme physical and/or verbal abuse, angry or hostile outbursts of anger or hostility 
aimed at the child(ren). 

• Excessive, brutal or bizarre punishment of child(ren), e.g., scalding with hot water, 
burning with cigarettes, forced feeding.  

• Threatens, brandishes or uses guns, knives or other weapons against or in the 
presence of other household members. 

• Violently shakes or chokes baby or young child(ren) to stop a particular behavior. 
• Behavior that is reckless, unstable, raving, or explosive. 
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Caretaker(s) appears unwilling and/or unable to meet the child(ren)’s basic needs for 
food, clothing, shelter and/or medical care. 

• No food provided or available to child, or child starved or deprived of food or drink for 
prolonged periods. 

• Child without minimally warm clothing in cold months; clothing extremely dirty. 
• No housing or emergency shelter; child must or is forced to sleep in street, car, etc.; 

housing is unsafe, without heat, etc. 
• Caretaker does not seek treatment for child’s immediate and dangerous medical 

condition(s) or does not follow prescribed treatment for such condition(s). 
• Child appears malnourished. 

 

Caretaker(s) appears unwilling and/or unable to provide adequate supervision of the 
child(ren). 

• Caretaker does not attend to child to the extent that need for adequate care goes 
unnoticed or unmet (e.g., although caretaker present, child can wander outdoors 
alone, play with dangerous objects, play on unprotected window ledge or be exposed 
to other serious hazards). 

• Caretaker leaves child alone (time period varies with age and developmental stage). 
• Caretaker makes inadequate and/or inappropriate child care arrangements or 

demonstrates very poor planning for child's care. 
• Caretaker routinely fails to attempt to provide guidance and set limits, thereby 

permitting a child to engage in dangerous behaviors. 
 

Caretaker(s) likely caused serious physical harm to the child(ren) or has made a  
plausible threat of serious harm. 

• Other than accidental, caretaker likely caused serious abuse or physical injury, i.e. 
fractures, poisoning, suffocating, shooting, burns, bruises/welts, bite marks, choke 
marks. 

• Caretaker, directly or indirectly, makes a believable threat to cause serious harm, 
e.g., kill, starve, lock out of home. 

• Caretaker plans to retaliate against child for CPS investigation or disclosure of abuse 
or maltreatment. 

• Caretaker has used torture or physical force that bears no resemblance to 
reasonable discipline, or punished child beyond the duration of the child's 
endurance. 

 

Caretaker(s) views, describes or acts toward the child(ren) in predominantly negative 
terms and/or has extremely unrealistic expectations of the child(ren). 

• Describes child as evil, possessed, stupid, ugly or in some other demeaning or 
degrading manner. 

• Curses and/or repeatedly puts child down. 
• Scapegoats a particular child in the family. 
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• Expects a child to perform or act in a way that is impossible or improbable for the 
child's age (e.g., babies and young children expected not to cry, expected to be still 
for extended periods, be toilet trained or eat neatly).  

 

Child(ren)’s current whereabouts cannot be ascertained and/or there is reason to believe 
that the family is about to flee or refuses access to the child(ren). 

• Family has previously fled in response to a CPS investigation. 
• Family has removed child from a hospital against medical advice.  
• Family has history of keeping child at home, away from peers, school, or others for 

extended periods. 
• Family could not be located despite appropriate diligent efforts. 

 

Child(ren) has been or is suspected of being sexually abused and the caretaker(s) is 
unable or unwilling to provide adequate protection of the child(ren). 

• It appears that caretaker has committed rape, sodomy or has had other sexual 
contact with child. 

• Child may have been forced or encouraged to sexually gratify caretaker or others, or 
engage in sexual performances or activities. 

• Access by possible or confirmed sexual abuser to child continues to exist.  
 

The physical living conditions are hazardous. 

• Leaking gas from stove or heating unit.  
• Dangerous substances or objects stored in unlocked lower shelves or cabinets, 

under sink or in open.  
• Lack of water or utilities (heat, plumbing, electricity) and no alternate provisions 

made. 
• Peeling lead-based paint accessible to young child. 
• Hot water/steam leaks from radiator. 
• No guards or open windows/broken/missing windows.  
• Garbage not disposed of properly. 
• Perishable food not properly stored or already rotted or spoiled.  
• Evidence of human or animal waste throughout living quarters.  
• Serious illness or significant injury has occurred due to living conditions and these 

conditions still exist.  
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Child(ren) is afraid of and/or extremely uncomfortable around people living in or 
frequenting the home. 

• Child cries, cowers, cringes, trembles or otherwise exhibits fear in the presence of 
certain individuals or verbalizes such fear. 

• Child exhibits severe anxiety related to situation associated with a person(s) in the 
home, e.g., nightmares, insomnia. 

• Child reasonably expects retribution or retaliation from caretakers. 
 

Child(ren) has a positive toxicology for drugs and/or alcohol. (NYC Required) 

• Child(ren) (0-6 mos.) is born with a positive toxicology for drugs and/or alcohol. 
 

Child(ren) is on Sleep Apnea Monitor. (NYC Required) 

• Child(ren) is required to be on a sleep apnea monitor.  A diagnosed medical 
condition, or suspicion thereof, exists that places the child(ren) at risk of involuntarily 
ceasing to breathe. 

 

Weapon noted in CPS report or found in home. (NYC Required) 

• A firearm, such as a gun, rifle or pistol is in the home and may be used as a weapon. 
• If a firearm is in the home, it may be assumed that ammunition is available and that 

the firearm may be discharged at will. 
 

Other (specify): 

Possible examples: 

• Child(ren)’s behavior likely to provoke caretaker to harm the child(ren).  
• Unexplained injuries to a child(ren).  
• Abuse or neglect to related child(ren)’s death, or unexplained child(ren)’s death. 
• Serious allegations with significant discrepancies or contradictions by caretaker(s), or 

between caretaker(s) and collateral contacts.  
• Caretaker(s) refuses to cooperate or is evasive. 
• Criminal behavior occurring in the presence of the child(ren), or the child(ren) is 

forced to commit a crime(s) or engage in criminal behavior.  
 

No Safety Factors Identified 
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Appendix B: CPS Safety Interventions/Definitions 

1. Intensive Home Based Family Preservation Services: Short term, intensive, in-home 
intervention aimed at restoring family functioning to enable maximum impact of case 
planning.  Program elements include small caseloads (6-10) per caseworker, caseworkers 
on-call 24 hours to enable intervention at peak crisis points, counseling and parent skill-
building services provided primarily in-home, 4-6 week intervention aimed at preparing 
families to be discharged and to avoid dependency and promote skill building.  

 

2. Emergency Shelter: Arranging for placement of caretaker(s) and child(ren) in a public or 
privately run emergency shelter, due to factors such as homelessness, eviction or 
catastrophe and in the absence of any alternative supportive resources.  Emergency shelter 
situations are intended to be a temporary, rather than a permanent solution to shelter needs. 

 

3. The non-Offending Caretaker Is Moving to a Safe Environment with the Children: 
Arranging for a residential program for victims of domestic violence and their children.  This 
may include domestic violence shelters, safe dwellings, or safe homes, which are usually 
undisclosed, secure locations that provide for the immediate and basic needs of victims of 
domestic violence.  Services may include food, clothing, shelter, victim advocacy and 
information and referral. 

 

4. Authorization of emergency food/cash/goods: Arranging for, referring or providing 
emergency food, clothing, furniture and other basic household items to those clients in need.  
Resources may include emergency food stamps, emergency authorization payment for 
clothing, furniture and/or other basic necessities, community-based food pantries and other 
religious or civic organizations assisting those in need. 

 

5. Judicial Intervention: May include filing petitions for Neglect or Abuse (Article 10), PINS 
(Article 7), JD (Article 3), Orders of Protection, Termination of Parental Rights and related 
requests for court-ordered supervision and/or services. 

 

6. Law Enforcement Involvement: May include contacting local, county or state law 
enforcement agencies to report a crime and/or to seek law enforcement intervention. 

 

7. Emergency Medical/Mental Health Services: Arranging for or referring to emergency 
medical and mental health services including, but not limited to, hospital emergency rooms, 
ambulance/EMT services, mobile mental health crisis units, walk-in health clinics, and 
suicide hotlines.  

 

8. Immediate and regulated in-home supervision/monitoring: Includes CPS in-home 
supervision and monitoring, including increased frequency and regularity (above the norm) 
of home visits and referring or arranging for the provision of immediately necessary in-home 
services, such as visiting nurse services, public health nurses, home health aides, 
homemaker services and supervised visitation.   
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9. Emergency Alcohol Abuse Services: Referring or arranging for the provision of 
emergency alcohol services including, but not limited to, emergency in-patient medical 
treatment/detoxification, out-patient treatment for an alcohol overdose and/or placement in a 
substance abuse residential treatment facility.  

 

10. Emergency Drug Abuse Services: Referring or arranging for the provision of emergency 
drug abuse services including, but not limited to, emergency in-patient medical 
treatment/detoxification, out-patient treatment for a drug overdose and/or placement in a 
substance abuse residential treatment facility. 

 

11. Correction or removal of hazardous/unsafe living conditions: Eliminating hazardous or 
unsafe living conditions which may involve contacting the local Health Department or local 
Fire Department for a home inspection and recommendations, client advocacy with 
landlords or public housing authorities and/or assistance in relocating the family.    

 

12. Placement - Foster Care: Protective removal and foster care placement of child(ren) 
assessed to be in immediate danger of serious harm or who may be a threat to others in the 
home and/or community. 

 

13. Placement - Alternate Caregiver: Protective or voluntary removal and placement of 
child(ren) with appropriate alternative caregivers. Alternate caregivers may include, but are 
not be limited to, non-custodial parents, relatives, friends, or neighbors. Alternate caregivers 
may petition for custody or guardianship of the child(ren). 

 

14. Use of family, neighbors or other individuals in the community as safety resources 
(Specify): Consider immediate or extended family members, neighbors, co-workers, 
affiliated religious group members and other community contacts that can play a role in 
assuring the health and safety of child(ren). These voluntary safety resources may provide 
temporary child care, temporary shelter, transportation, donations of food, clothing, 
household goods, in-home monitoring and/or other forms of assistance to the family. 

 

15. Alleged perpetrator has left the home voluntarily, current caretaker will appropriately 
protect the victim with CPS monitoring: The alleged perpetrator has voluntarily left the 
home and the current caretaker(s) has agreed to protect the child(ren) from further harm and 
is cooperating with CPS supervision and monitoring. 

 

16. Alleged perpetrator has left the home in response to legal action: The alleged 
perpetrator has left the home as the result of law enforcement intervention and/or a court 
order to vacate the home, stay away from the child(ren) and/or refrain from committing a 
family or criminal offense against the children. 

 

17. Other (Specify) 


